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1 Einleitung 

MAXWELL ist ein Programm, das die Finite-Elemente-Methode zur Berechnung statischer 

und zeitlich veränderlicher elektrischer und magnetischer Felder in 2D und 3D verwendet.  

 

Abbildung 1:    Übersicht der mit MAXWELL berechenbaren Felder 

In diesem Skript wird nach einer kurzen Erläuterung der Finite-Elemente-Methode aus-

schließlich die Verwendung von MAXWELL zur Berechnung magnetostatischer Probleme 

erläutert. Dabei wird kein Anspruch auf Vollständigkeit erhoben, sondern vielmehr versucht, 

Ungeübten den Einstieg in und den Umgang mit MAXWELL zu erleichtern. 

2 Finite-Elemente-Methode 

Die Finite-Elemente-Methode ist ein numerisches Verfahren zum Lösen von partiellen Diffe-

rentialgleichungen. Das Berechnungsgebiet wird dabei in eine beliebig große Anzahl von end-

lich (finit) großen Elementen unterteilt, die sich mit einer endlichen Anzahl von Parametern 

beschreiben lassen. Innerhalb dieser Elemente werden Ansatzfunktionen definiert, die geeig-

net sind, die exakte Lösung des zu berechnenden Felds hinreichend genau zu approximieren. 

Neben Anfangs- und Randbedingungen werden Übergangsbedingungen an den Elementgren-

zen definiert, welche die Stetigkeit der Lösung an den Elementgrenzen sicherstellen. Stetig-

keit bedeutet in Bezug auf die Feldlinien der magnetischen Induktion, dass diese von einem 

zum nächsten Element nicht unterbrochen werden. Durch Einsetzen der Ansatzfunktionen 

sowie der Anfangs-, Rand- und Übergangsbedingungen in die Differentialgleichung erhält 

man ein numerisch lösbares lineares Gleichungssystem, dessen Lösung letztendlich eine Ap-

proximation der Lösung der betrachteten Differentialgleichung darstellt. Die Größe des zu 

lösenden Gleichungssystems hängt maßgeblich von der Anzahl der finiten Elemente ab. Die 

zu lösende Gesamtmatrix des Gleichungssystems ist dünn besetzt, da jedes Element nur mit 

wenigen benachbarten Elementen verbunden ist und somit die meisten Einträge der Gesamt-

matrix Null sind. Deshalb bietet sich zur Lösung des Gleichungssystems ein direktes Lö-

sungsverfahren, wie beispielsweise der Gauß-Algorithmus an. 
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2.1 Finite Elemente und adaptive Netzverfeinerung 

Bei zweidimensionalen Problemen sind die finiten Elemente dreieckig, bei dreidimensionalen 

Problemen sind es Tetraeder (vierseitige Pyramiden). Die Endpunkte der Kanten der finiten 

Elemente heißen Knoten. Alle finiten Elemente zusammen bilden das Netz (Mesh). MAX-

WELL verfügt über eine adaptive Netzverfeinerung, d.h. MAXWELL führt eine lokale 

Fehlerbetrachtung durch, der in der Magnetostatik die Gleichung ∇•B=0 , d.h. es existieren 

keine magnetischen Monopole, zu Grunde liegt. Der lokale Fehler ergibt sich durch eine von 

Null verschiedene Divergenz an der betrachteten Stelle. Der lokale Fehler ist groß, wenn die 

Approximation des einzelnen Elements zu ungenau ist. Finite Elemente lassen sich umso ge-

nauer approximieren, je feiner und gleichmäßiger sie sind (gleiche Kantenlängen der Dreiecke 

bzw. Tetraeder). In der Abbildung 2 ist beispielhaft die Approximation eines eindimensiona-

len Systems der Eingangsvariablen x dargestellt. y(x) sei die exakte Lösung des betrachteten 

Systems. Das Lösungsgebiet ist bereits in finite Elemente unterteilt. Die finiten Elemente sind 

Strecken, die sich lediglich in ihrer Länge unterscheiden können und die Elementgrenzen sind 

Punkte. Je enger die Unterteilung ist, desto genauer kann die exakte Lösung angenähert wer-

den. Dazu ist es hilfreich, sich vorzustellen, die Interpolation zwischen den Intervallgrenzen 

sei linear, wenngleich tatsächlich Polynome höherer Ordnung zur Anwendung kommen. Es 

wird außerdem klar, dass es sinnvoll ist, in Bereichen großer Krümmung feiner zu elementie-

ren. Krümmung bezeichnet hier die Höhe der zweiten Ableitung der Zielfunktion bzw. die 

Änderung der ersten Ableitung. Die feinere Elementierung in Bereichen starker Krümmung 

ist in der Abbildung 2 dargestellt.  

 

Abbildung 2:    Annäherung der exakten Lösung y(x) einer DGL mit Hilfe von finiten Elementen 

Um auch die Bereiche großer Abweichung des Feldwerts von Null ausreichend genau zu dis-

kretisieren und somit den Fehler zu minimieren, ist eine globale, d.h. ganzheitliche Verfeine-

rung des Gitternetzes aufgrund des damit verbundenen erhöhten Speicher- und Rechenzeit-

aufwands nicht sinnvoll. Die adaptive Netzverfeinerung beschränkt sich auf die Bereiche des 



 

Fachgebiet Mikrotechnik der TU Berlin 5 www.fmt.tu-berlin.de 

Ausschließlich für den Übungsgebrauch  Autor dieses Skripts: Dipl.-Ing. Martin Kelp 

 

Berechnungsgebiets, wo der errechnete Fehler groß ist (der zulässige Percent Error wird hier 

überschritten) und elementiert dort mit jedem iterativen Rechenzyklus zur Lösung des Glei-

chungssystems entsprechend feiner. Dies geschieht so lange, bis eine der beiden zu definie-

renden Abbruchbedingungen, Maximum Number of Passes und Percent Error, die Netzver-

feinerung beendet. Mit Maximum Number of Passes wird die maximale Anzahl iterativer Re-

chenzyklen der Netzverfeinerung zum Erreichen einer konvergenten Lösung begrenzt. Per-

cent Error beschreibt das in Prozent umgerechnete Verhältnis zwischen der Energie, die sich 

aus den lokalen Fehlern ergibt und der Gesamtfeldenergie. Wird Maximum Number of Passes 

erreicht oder der zulässige Percent Error unterschritten, bricht die Berechnung der Lösung des 

Gleichungssystems ab.  

2.2 Schritte einer FEM-Berechnung 

Kommerzielle FEM-Software wird zur Berechnung mechanischer, fluiddynamischer, elektro-

magnetischer und anderer physikalischer Probleme genutzt. Trotz der Verschiedenheit der 

physikalischen Fragestellung ähnelt sich die Vorgehensweise zur Modellierung in den unter-

schiedlichen Programmen stark. Sie gliedert sich in folgende Schritte:  

 

1. Preprocessing 

a. Erstellen der Geometrie  

b. Zuweisen von Materialeigenschaften, z.B. magnetische Permeabilität 

c. Zuweisen von Lasten (z. B. Verteilung von Strömen in einer elektromag-

netischen Analyse) und Randbedingungen (z.B. Symmetriebedingungen 

in einer elektromagnetischen Analyse)  

d. Elementierung 

2. Solver 

a. Erstellen der Gleichungssysteme  

b. Lösen der Gleichungssysteme 

3. Postprocessing 

a. Darstellung der Ergebnisse z. B. mit Feldliniendiagrammen  

b. Interpretation der Ergebnisse 

 

Das Erstellen und Lösen der Gleichungssysteme führt das FE-Programm in der Regel eigen-

ständig aus. Auf die Einzelheiten des Preprocessings und des Postprocessings bei Verwen-

dung von MAXWELL wird in den folgenden zwei Kapiteln ausführlich eingegangen.  
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3 Preprocessing 

3.1 Koordinatensysteme 

Das kartesische Koordinatensystem (XY-Ebene) wird für so genannte 2,5-dimensionale Ge-

ometrien genutzt, d.h. für Geometrien, die keine Hinterschneidungen in der dritten Raumrich-

tung aufweisen und sich durch lineares Austragen entlang der dritten Raumachse der in der 

XY-Ebene gezeichneten Geometrie ergeben. Das zylindrische Koordinatensystem verwendet 

man für rotationssymmetrische Geometrien. Diese werden in einem Quadranten so erstellt, 

dass eine 360°-Rotation um die Rotationsachse Z die eigentliche zu berechnende rotations-

symmetrische Geometrie ergibt. 

 

Wenn eine Modellierung der Geometrie in 2D möglich ist, ist die zweidimensionale Berech-

nung in jedem Fall zu bevorzugen, da die zu lösenden Gleichungssysteme im Dreidimensio-

nalen schnell deutlich komplexer als im Zweidimensionalen werden und die Rechenzeit damit 

beträchtlich zunimmt. Ist es aber notwendig ein Problem in drei Dimensionen zu berechnen, 

so sollte versucht werden, das Gleichungssystem durch Nutzung von Symmetrien so weit wie 

möglich zu reduzieren (dazu später mehr). Der Vorteil dreidimensionaler FEM-Berechnungen 

liegt darin, prinzipiell jede beliebige Geometrie berechnen zu können, während zweidimensi-

onale Berechnungen zwar ressourcenschonender und im Allgemeinen schneller sind, ihr Ein-

satz jedoch häufig daran scheitert, dass die zu berechnende Geometrie nicht im Zweidimensi-

onalen abgebildet werden kann. Ein weiterer Vorteil dreidimensionaler Systeme ergibt sich 

im Hinblick auf das Marketing bei Kunden. 3D-Systeme wirken professioneller und die aus-

gegeben Bilder sind optisch ansprechender. Nicht zuletzt erlauben sie es auch im Lesen von 

technischen Zeichnungen ungeübten Personen die Geometrie zu erkennen. 

 

Bei 2D-Rechnungen ist zu beachten, dass, berechnet man beispielsweise die Reluktanzkraft, 

die auf den beweglichen Schenkel des in 2D im kartesischen Koordinatensystem berechneten 

Magnetkreises wirkt, so kalkuliert MAXWELL die Reluktanzkraft für einen in der dritten 

Raumrichtung um 1 m ausgedehnten Magnetkreis. Dieses Ergebnis muss anschließend auf die 

tatsächliche Tiefenausdehnung umgerechnet werden. Vergleicht man die Ergebnisse der im 

Dreidimensionalen berechneten Kraft mit der auf die gleiche Tiefenausdehnung umgerechne-

ten im Zweidimensionalen, im kartesischen Koordinatensystem berechneten Kraft, so zeigt 

sich eine Abweichung. Diese Abweichung rührt daher, dass MAXWELL im Zweidimensio-

nalen, im kartesischen Koordinatensystem die Streufelder nur in der XY-Ebene und nicht in 

der dritten Raumrichtung berechnet. Bei rotationssymmetrischen Geometrien, die im Zwei-

dimensionalen, zylindrischen Koordinatensystem berechnet wurden, ergibt sich keine Abwei-

chung zur dreidimensionalen Berechnung, da die Streufelder ebenfalls rotationssymmetrisch 

sind und somit schon bei der Berechnung in der zu rotierenden Ebene mitberücksichtigt wer-

den.  
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3.2 Erstellen der Geometrie 

Nach dem Start von MAXWELL öffnet sich die in der Abbildung 3 gezeigte Benutzerober-

fläche und im Project Tree im Project Manager wird automatisch ein neues Project angelegt. 

Über die beiden markierten Symbole der Toolbar kann nun der Arbeitsraum für ein MAX-

WELL 2D oder 3D Design geöffnet werden. 

 

Abbildung 3:    Benutzeroberfläche von MAXWELL 
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Die Art des zu berechnenden Felds (elektrisch, magnetisch) bestimmt man, indem man in der 

Menüleiste ►Maxwell 2D/3D►Solution Type aufruft und entsprechendes auswählt. Für die 

Berechnung von zweidimensionalen Problemen stehen zusätzlich zwei verschiedene Koordi-

natensysteme zur Verfügung, das kartesische Koordinatensystem (Koordinaten X,Y) und das 

Zylinderkoordinatensystem (Koordinaten R,Z). Die Kenntnis verschiedener Shortcuts, die in 

der Tabelle 1 aufgeführt sind, erleichtert den Umgang mit MAXWELL. 

 

Shortcut Funktion 

B Oberfläche/Objekt hinter der aktuellen Auswahl auswählen 

F Oberflächenauswahlmodus 

O Objektauswahlmodus 

Strg+A Alle sichtbaren Objekte auswählen 

Strg+D Modellgröße an Fensterbereich anpassen 

Shift+linke Maustaste Modell ziehen 

Alt+linke Maustaste Modell rotieren 

Tabelle 1:    Hilfreiche MAXWELL Shortcuts 

Zusätzlich können die gewünschte Längeneinheit der zu erstellenden Geometrie über 

►Modeler►Units und die Eigenschaften des Hintergrundnetzes über ►View►Grid Set-

tings eingestellt werden. Die mit Augen versehenen Piktogramme dienen zum Ein- und Aus-

blenden der Bauteile. 

Es gibt verschiedene Möglichkeiten, Objekte in MAXWELL zu erstellen. MAXWELL bietet 

eine Auswahl von Piktogrammen zum Erstellen von Grundgeometrieformen, geraden Linien, 

Kurven und Bögen. Alle Objekte lassen sich mit Unite, Subtract, Intersect, Split, Imprint be-

liebig miteinander kombinieren, mit Move, Rotate, Mirror lassen sie sich verschieben, rotie-

ren und spiegeln, mit Duplicate Along Line, Duplicate Around Axis, Duplicate Mirror lassen 

sie sich vervielfältigen. Die Piktogramme zum Erstellen und Bearbeiten von Objekten heben 

sich aufgrund der gelben Farbe von den übrigen Piktogrammen deutlich ab. Beim Erstellen 

von Objekten besteht die Möglichkeit, die Koordinaten während des Erstellens direkt in die 

Coordinate Entry Fields einzutragen, nachträglich können sie per Mouseklick auf das Create-

Symbol im Modeler Design Tree geändert werden. Es können Zahlen, Variablen oder einfa-

che mathematische Zusammenhänge wie beispielsweise zur Berechnung eines Sinus sin() 

eingesetzt werden. Gibt man eine Variable zum ersten Mal ein, so erscheint ein Fenster, in 

dem nach dem Wert (Value) der Variable gefragt wird. Hier müssen eine Zahl und eine Ein-

heit eingegeben werden. Um eine bessere Übersichtlichkeit zu erreichen, kann man die ein-

zelnen Objekte umbenennen und ihre Farbe ändern. Zusätzlich besteht die Möglichkeit mit 

CAD-Software erstellte Bauteile oder Baugruppen als Step-Dateien zu importieren über 
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►Modeler►Import. Dabei ist zu beachten, dass sich die Abmaße importierter Objekte 

nachträglich nicht verändern lassen. Mittels ►MAXWELL 2D/3D►Create 2D/3D Design 

lassen sich zweidimensionale Objekte in dreidimensionale Objekte umwandeln und umge-

kehrt. Das lineare Verschieben, Rotieren des bestehenden Koordinatensystems sowie das Ein-

fügen eines relativen Koordinatensystems ist möglich, wird jedoch selten genutzt. Vermessen 

lassen sich die erstellten Objekte über ►Modeler►Measure.  

Ist die Modellgeometrie vollständig erstellt, wird der Berechnungsraum, innerhalb dem 

MAXWELL das magnetische Feld berechnet, eingegrenzt. In MAXWELL 2D zeichnet man 

zunächst ein Rechteck um das Modell, bzw. erstellt mit ►Create Region (Piktogramm in 

Form eines perspektivischen Würfels mit roten Kanten) eine Umgebung, die üblicherweise 

200 % größer als das Modell ist. Mittels ►Select Edges wählt man in beiden Fällen die Kan-

ten der Umgebung aus und definiert sie über ►Assign Boundary►Balloon als Berech-

nungsraum. Zu beachten ist, dass im Zylinderkoordinatensystem eine Kante der Umgebung 

mit der Rotationsachse zusammenfällt und nur die drei übrigen Kanten zur Zuweisung der 

Boundary Balloon ausgewählt werden. In MAXWELL 3D genügt es die Region zu erstellen, 

eine Boundary Balloon Zuweisung ist nicht erforderlich. Dem Berechnungsraum wird stan-

dardmäßig Vacuum als Material zugewiesen.  

3.3 Materialzuweisung 

MAXWELL verfügt über eine umfangreiche Materialdatenbank, die durch Rechtsklick auf 

das Objekt und ►Assign Material geöffnet wird. Die vorhandenen Materialien können über 

View/Edit, Clone bearbeitet werden. So ist es beispielsweise möglich, die Magnetisierungs-

richtung eines Permanentmagneten zu ändern, bzw. durch Auswahl des Zylinderkoordinaten-

systems (im Materialfenster) die Art der Magnetisierung von diametral auf radial zu ändern, 

indem man für die R-Koordinate -1 oder +1 einsetzt. Da die mit MAXWELL berechneten 

Bauteile im Anschluss üblicherweise auch gefertigt werden und die Materialparameter der 

Materialien aus der Datenbank von realen Materialien abweichen können, lassen sich für 

weichmagnetische Materialien die BH-Kurven (Neukurve) verändern oder in Form von *.tab 

oder *.bh Dateien importieren. Für hartmagnetische Materialien lassen sich die relative Per-

meabilität und die Koerzitivfeldstärke anpassen.  

3.4 Zuweisen von Lasten 

Im elektromagnetischen Fall bedeutet das Zuweisen von Lasten, das Zuweisen einer elektri-

schen Erregung (Excitation). In der Regel werden dabei Spulen bestromt, um ein Magnetfeld 

zu erzeugen.  

3.4.1 Erstellen von Spulen in MAXWELL 3D 

Spulen werden als Objekt in MAXWELL 3D so erstellt, dass sie von mindestens einer Koor-

dinatenebene symmetrisch geschnitten werden. Dies erleichtert später das Zuweisen der 
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Bestromung. Als Material weist man ihnen üblicherweise Kupfer zu. Damit der Strom die 

Spule nicht verlässt, muss sie isoliert werden. Dazu wählt man die Spule aus und erzeugt an-

schließend mit ►Assign Boundary►Insulating die Isolation. Mit 

►Edit►Surface►Section wird in der die Spule symmetrisch schneidenden Koordinaten-

ebene eine Querschnittsebene erzeugt. Diese wird mit ►Edit►Boolean►Separate Bodies 

in zwei einzelne Hälften geteilt, von denen man nun eine auswählt. Über 

►Assign►Excitation►Current öffnet sich ein Fenster, in dem die Parameter des Stroms 

festgelegt werden können. Als Wert des Stroms müssen hier die Ampèrewindungen eingetra-

gen werden, d.h. bei einer Spule mit 150 Windungen, die von 2 A durchflossen werden soll, 

wird hier 300 A eintragen. Solid bedeutet dabei, dass MAXWELL die Spule als aus Vollma-

terial bestehend ansieht, Stranded bedeutet, MAXWELL nimmt an, dass der Spulenkörper in 

unendlich viele einzelne, gegeneinander isolierte Windungen unterteilt ist. Die zweite Hälfte 

der Querschnittsebene wird gelöscht.  

3.4.2 Erstellen von Spulen in MAXWELL 2D 

Spulen werden in MAXWELL 2D im kartesischen und im Zylinderkoordinatensystem, wie in 

der Abbildung 4 dargestellt, gezeichnet. Das Zuweisen einer Bestromung erfolgt analog zum 

Vorgehen in MAXWELL 3D, ausgenommen, dass das Erzeugen und Teilen der Querschnitts-

ebene sowie das Isolieren der Spule überflüssig sind.  

 

Abbildung 4:    Darstellung von Spulen in MAXWELL 2D: im Zylinderkoordinaten- 

          system (links), im kartesischen Koordinatensystem (rechts) 

3.5 Symmetriebedingungen 

Da die Anzahl der Rechenschritte und damit die Rechenzeit zur Lösung eines Gleichungssys-

tems exponentiell mit der Anzahl an Variablen steigt, ist es sinnvoll, das Modell und damit 

die Element- und Knotenzahl mit Hilfe von Randbedingungen so klein wie möglich zu halten. 

Dazu werden Symmetriebedingungen definiert, welche den Symmetriekanten bzw. -flächen 

des Modells zugewiesen werden. In MAXWELL stehen verschiedene Arten von Randbedin-
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gungen zu Verfügung. Diese werden im Folgenden kurz erläutert. Zu beachten ist, dass die 

Wirkung auf magnetische und elektrische Felder genau invertiert ist.  

3.5.1 Symmetry odd 

Diese Randbedingung definiert, dass der magnetische Fluss, also die Feldlinien des B-Felds, 

tangential zur Grenzfläche verlaufen (siehe Abbildung 5). Im Fall eines E-Felds treten die 

Feldlinien normal durch die Grenzfläche ein- oder aus.  

3.5.2 Symmetry even 

Diese Randbedingung definiert, dass der magnetische Fluss, also die Feldlinien des B-Felds, 

normal in die Grenzfläche ein- bzw. austreten (siehe Abbildung 5). E-Feldlinien hingegen 

laufen tangential zu dieser Grenzfläche.  

 

Abbildung 5:    Feld eines Stabmagneten (links), Verkleinerung des Modells mit Hilfe von Symmetriebe-

dingungen (mittig) und zugehörige Elementierung (rechts) 

Zuweisen von Symmetry odd/Symmetry even 

Um diese Symmetriebedingungen anwenden zu können, reduziert man das Modell zuvor so, 

dass Schnittkanten entstehen, an denen der magnetische Fluss tangential oder normal verläuft. 

Als Boundary Balloon wählt man in MAXWELL 2D alle Kanten des Berechnungsraums, die 

keine Symmetriekanten sind. In MAXWELL 3D ist es nicht erforderlich, die Region als 

Boundary Balloon zu definieren. Anschließend weist man die entsprechende Symmetrie in 

MAXWELL 2D der ausgewählten Symmetriekante in MAXWELL 3D der ausgewählten 

Symmetrieebene über ►Assign Boundary►Symmetry►odd/even zu.  
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3.5.3 Master und Slave 

Liegt als MAXWELL-Modell eine Geometrie mit zyklischen Symmetrien vor, kann diese mit 

Hilfe der Master- und Slave-Randbedingungen reduziert werden um die Rechenzeit zu ver-

kürzen. Dabei lässt sich ausnutzten, dass sich identische Feldverläufe bei bestimmten Win-

keln wiederholen (siehe Abbildung 6). Statt der Berechnung der gesamten 360°-Geometrie, 

wird nur ein Winkelsegment modelliert und berechnet. Anhand der Ergebnisse für das Win-

kelsegment kann dann auf das Gesamtmodell rückgeschlossen werden.  

Eine zyklische Symmetrie ist gegeben, wenn an jedem Punkt entlang einer ersten Symmet-

rielinie (Master) der gleiche Betrag der magnetischen Feldstärke H auftritt wie entlang der 

zweiten Symmetrielinie (Slave). 

Liegt diese zyklische Symmetrie vor, reicht es aus nur ein Winkelsegment zu modellieren und 

die Grenzflächen in MAXWELL als „Master“ und als „Slave“ zu definieren. Je nach vorlie-

gender Symmetrie wird der Zusammenhang zwischen Master und Slave entsprechend defi-

niert als: 

 Slave  =  Master  

 Slave  =  - Master  

Durch das Zuweisen der Master-Slave-Randbedingung wird die Elementierung auf beiden 

Grenzflächen kompatibel gestaltet, d.h. die Knoten des Masters liegen an den gleichen Positi-

onen wie die Knoten des Slaves. 

Dies soll im Folgenden anhand der Abbildung 6 erläutert werden.  

 

Abbildung 6:    Master und Slave Randbedingungen am Beispiel einer ausgelenkten Magnetkupplung 

Ein 120°-Segment der ausgelenkten Magnetkupplung weist zyklische Symmetrie des Typs 

Slave = Master auf (siehe Abbildung 6 links), während ein 60°-Segment zyklische Symmetrie 

des Typs Slave = - Master zeigt (siehe Abbildung 6 Mitte). Der Unterschied zwischen beiden 

besteht darin, dass die Magnete, die von den Segmentgrenzen geschnitten werden, in Abbil-

Zyklische Symmetrie

Slave = -Master

Zyklische Symmetrie

Slave = Master
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dung 6 links gleichsinnig und in Abbildung 6 Mitte gegensinnig magnetisiert sind. Der rechte 

Bildteil zeigt den Verlauf des berechneten Magnetfelds für ein 60°-Segment mit Hilfe von 

Slave = - Master. Es ist zu erkennen, dass die Feldlinien an den Segmenträndern ineinander 

münden. Allerdings ist die Feldrichtung genau gegensinnig (Slave = - Master), was aus dem 

Modell der Magnetkupplung (siehe Abbildung 6 Mitte) resultiert. 

Zuweisen von Master und Slave 

Zunächst wird das Objekt sinnvollerweise auf das kleinstmögliche Segment, auf das die Sla-

ve = Master bzw. die Slave = - Master Beziehung angewendet werden kann, reduziert. An-

schließend weist man den Segmentschnittkanten bzw. Segmentschnittebenen über 

►Assign Boundary►Master bzw. Slave die jeweilige Randbedingung zu. Der Anleitung 

des sich öffnenden Fensters folgend erstellt man einen New Vector U. Dieser muss bei einem 

MAXWELL-2D-Modell im Modellursprung starten und entlang der einen Segmentschnitt-

kante verlaufen. Die Richtung muss dabei der positiven Koordinatenrichtung entsprechen 

(ggf. Swap Direction auswählen, um die Richtung umzukehren). Im Slave-Fenster definiert 

man die Slave-Boundary zur zuvor definierten Master Boundary und wählt die Beziehung 

Slave = Master (Bs = Bm) bzw. die Slave = - Master (Bs = -Bm). Genau wie bei den 

odd/even-Randbedingungen werden nur die nicht als Symmetriekanten definierten Kanten des 

Berechnungsbereichs als Boundary Balloon definiert.  

In MAXWELL 3D ist das Vorgehen äquivalent, nur werden hier die Segmentschnittebenen 

ausgewählt und der Vektor, der zur Definition der Master- bzw. Slaverandbedingung ge-

zeichnet wird (Vector U), hat den Ursprung und die positive Richtung der Koordinatenachse, 

welche die Rotationssymmetrieachse darstellt. Die Richtung des Vectors V muss jeweils in 

positive Koordinatenrichtung weisen und kann ggf. mit Reverse Direction geändert werden.  

3.6 Parameter 

Bei der Auslegung eines elektromagnetischen Aktors ist neben dem erzeugten Magnetfeld je 

nach Aktorprinzip besonders das erzeugte Drehmoment oder die erzeugte Kraft der bewegli-

chen Komponenten von Interesse. Damit diese mitberechnet werden, muss, bevor die Berech-

nung durchgeführt wird, der oder den Komponenten, auf welche die zu berechnende Kraft, 

bzw. das Drehmoment wirkt, Kraft oder Drehmoment als Parameter zugewiesen werden. Dies 

erfolgt durch ►Assign Parameter►Force/Torque.  

3.7 Manuelle Vernetzungssteuerung 

Wie bereits beschrieben, verfeinert MAXWELL eigenständig das Netz adaptiv bei jedem ite-

rativen Rechenzyklus. Das Netz lässt sich zusätzlich manuell verfeinern, um die Anzahl an 

iterativen Rechenschritten zu verringern, die durchlaufen werden, bis ein ausreichend feines 

Netz durch die adaptive Netzverfeinerung erzeugt ist.   

Dazu wählt man ►Assign Mesh Operation►Inside Selection►Length Based. Es öffnet 

sich ein Fenster, in dem man die maximale Länge der finiten Elemente und/oder die maxima-
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le Anzahl dieser beschränken kann. Anzeigen lassen kann man sich das Netz im ausgewählten 

Objekt per ►Rechtsklick►Plot Mesh.  

3.8 Solution Setup, Optimetrics und Berechnung 

Um eine Berechnung zu starten, muss durch Rechtsklick auf Analysis ein Solution Setup an-

gelegt werden. Hier werden die bereits erläuterten Abbruchbedingungen Maximum Number 

of Passes und Percent Error definiert. Mit einem Maximum Number of Passes von 20 und 

einem Percent Error von 0,1 erhält man in der Regel in endlicher Zeit ein konvergentes, hin-

reichend genaues Ergebnis.  

Um eine Variation einer eingeführten Variable zu berechnen, beispielsweise das schrittweise 

Erhöhen des Stroms, Rotation eines Objekts um einen variablen Winkel etc. muss zudem un-

ter ►Optimetrics ein Parametric Setup hinzugefügt werden. Die Variable kann so mit kon-

stanter Schrittweite sowohl erhöht als auch verringert werden.  

Damit die Ergebnisse der Feldberechnung einzelner Variationen anschließend auch zur Ver-

fügung stehen sollte im gleichen Fenster unter Options ein Häkchen bei „Save Fields and 

Mesh“ gesetzt werden.  

Das einmal erstellte Analysenetz lässt sich mit einem Häckchen bei „Copy geometrically 

equivalent meshes“ für verschiedene Variationen der parametrischen Analyse wiederverwen-

den. „Copy geometrically equivalent meshes“ lässt sich jedoch nur einstellen, falls bei den 

einzelnen Variationen keine geometrische Änderung, wie beispielsweise eine Längenände-

rung stattfindet.  

Die Validierung des zu berechnenden Modells erfolgt durch Anklicken des grünen Hakens. 

Fehler im Modell werden so vor Beginn der Berechnung entdeckt und angezeigt. Die Berech-

nung startet durch Anklicken des grünen Ausrufezeichens und kann je nach Komplexität des 

Modells, Umfang der Variationen und Prozessorleistung bzw. vorhandenem Arbeitsspeicher 

wenige Sekunden bis mehrere Tage dauern.  

4 Postprocessing 

4.1 Ergebnisse 

Die Ergebnisse der Modellrechnung lassen sich in MAXWELL auf verschiedene Arten dar-

stellen. Die magnetische Induktion B und die magnetische Feldstärke H lassen sich sowohl in 

vektorieller Form als auch als Farbverläufe darstellen. In MAXWELL 2D wählt man dazu 

alle Objekte, in denen der Feldverlauf angezeigt werden soll und blendet anschließend das 

Feld mittels ►Fields►B/H ein. Zusätzlich lassen sich in MAXWELL 2D die Flusslinien des 

magnetischen Flusses (Flux A) anzeigen. In MAXWELL 3D wählt man entweder eine der 

drei Koordinatenebenen oder die Oberflächen der Objekte aus, um das Magnetfeld anzeigen 

zu lassen. Zwischen den Feldverläufen einzelner Variationsdurchgänge, d.h. bestimmter 

Kombinationen von Variablenwerten wechselt man durch Einsetzen der gewünschten Variab-
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lenwerte im Properties Window. Kräfte und Drehmomente werden über 

►Results►Solution Data in tabellarischer Form dargestellt. Zudem besteht die Möglichkeit, 

Variationsergebnisse wie beispielsweise die Kraft als Funktion des Wegs in einem Diagramm 

anzeigen zu lassen. Dazu wählt man ►Results►Create Magnetostatic Re-

port►Rectangular Plot. Es öffnet sich ein Fenster, in dem sich die Variablen den Dia-

grammachsen zuordnen lassen und ausgewählt werden kann, ob alle Variationen oder nur 

eine bestimmte Auswahl dargestellt werden soll. Darüber hinaus lassen sich die Daten auch 

als *.csv Dateien exportieren. Dazu genügt ein Rechtsklick auf das Diagramm ►Export.  

5 Kurzbeschreibungen 

5.1 MAXWELL 2D 

►Insert MAXWELL 2D Design 

►Solution Type Magnetostatic  

 Koordinatensystem kartesisch oder zylindrisch 

►Modeler►Units Millimeter 

►View►Grid Settings gewünschtes Hintergrundnetz einstellen 

Objekte zeichnen:  

 dabei Koordinaten während des Zeichnens direkt im Entry Window eingeben  

 nachträglich Maße verändern: im Modeler Design Tree bspw. CreateRectangle ankli-

cken, dann im Properties Window Maße ändern  

 Variablen oder einfache mathematische Zusammenhänge für Längen etc. eingeben  

 Objekte als Step-Dateien importieren ►Modeler►Import  

 aus vorhandenem 2D-Modell 3D-Modell erstellen 

►MAXWELL2D►Create 3D Design  
 Name, Farbe etc. einstellen ►Edit►Properties  

 Objekte miteinander kombinieren ►Edit►Boolean►Subtract/Intersect/Unite  

 einzelnes Objekt teilen ►Edit►Boolean►Split  

 Objekte bewegen Move (entlang einer Linie), Rotate (um eine Achse)  

 Objekte vermessen ►Modeler►Measure 

Material zuweisen: Assign Material  

 bestehendes Material aus Materialdatenbank  

o Magnetisierungsrichtung ändern: 1 oder 0 bei gewünschter Koordinate  

o BH-Kurve importieren ►BH Curve►Import Dataset (*.bh oder *.tab)  

o Parameter eines Permanentmagneten ändern Relative Permeability etc. 

Berechnungsraum definieren  
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 mit Piktogramm Region oder durch Zeichnen eines Rechtecks Berechnungsraum ca. 

200 % größer als Modell erstellen  

 im Zylinderkoordinatensystem muss eine Kante des Berechnungsraums deckungs-

gleich mit der Z-Achse sein (dies wird automatisch von MAXWELL angepasst)  

 im kartesischen Koordinatensystem alle Kanten des Berechnungsraum auswählen  

 im Zylinderkoordinatensystem alle Kanten, die nicht deckungsgleich mit der Z-Achse 

sind, auswählen  

 ►Assign Boundary►Balloon 

Lasten zuweisen:  

 Spule bestromen  

o Spulenquerschnittsfläche auswählen (im kartesischen Koordinatensystem nur 

eine der beiden Querschnittsflächen auswählen, die andere wird anschließend 

entsprechend mit entgegengesetzter Richtung bestromt)  

o ►Assign Excitation►Current  

o Current kann sein Wert, Variable, Formel  

o Solid = Spule besteht aus Kupfervollmaterial  

o Stranded = Spule besteht aus Windungen 

Parameter zuweisen:  

 Kraft, Drehmoment  

 bewegliche Komponente auswählen, auf welche die Kraft bzw. das Drehmoment wirkt  

 ►Assign Parameter►Force/Torque 

manuelle Netzverfeinerung (optional):  

 ►Assign Mesh Operation►Inside Selection►Length based  

o maximale Kantenlänge der finiten Elemente  

o maximale Anzahl der finite Elemente 

Analysis Setup erstellen:  

 ►Analysis►Add Solution Setup  

o Maximum Number of Passes  

o Percent Error 

 Optimetrics (optional)  

o ►Optimetrics►Add►Parametric  

o Variable, Start, Stop, Schrittweite auswählen  

o bei Änderung immer Update auswählen  

o Reiter Options: Häkchen setzen bei „save mesh and fields“ (zum Speichern der 

grafischen Feldinformationen) und „copy geometrically equivalent meshes“ 

(nur falls sich während der parametrischen Analyse keine geometrischen Grö-

ßen ändern, lässt sich dieses Häckchen setzen) 

Berechnung starten:  
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 Piktogramm Validate  

 Piktogramm Analyze all 

Ergebnisse ansehen:  

 alles auswählen ►Rechtsklick►Fields►B,H,A  

 Diagramme ►Results►Create Magnetostatic Report►Rectangular Plot  

 Daten exportierbar durch Rechtsklick auf das Diagramm ►Export  

 Tabelle ►Results►Solution Data 

5.2 MAXWELL 3D 

►Insert MAXWELL 3D Design 

►Solution Type Magnetostatic 

►ModelerL Units Millimeter 

►View►Grid Settings gewünschtes Hintergrundnetz einstellen 

Objekte zeichnen:  

 dabei Koordinaten während des Zeichnens direkt im Entry Window eingeben  

 nachträglich Maße verändern: im Modeler Design Tree bspw. CreateRectangle ankli-

cken, dann im Properties Window Maße ändern  

 Variablen oder einfache mathematische Zusammenhänge für Längen etc. eingeben  

 Objekte als Step-Dateien importieren ►Modeler►Import  

 aus vorhandenem 2D- ein 3D-Modell erstellen ►Maxwell 3D►Create2D Design 

 Name, Farbe etc. einstellen ►Edit►Properties  

 Objekte miteinander kombinieren ►Edit►Boolean►Subtract/Intersect/Unite  

 einzelnes Objekt teilen ►Edit►Boolean►Split  

 Objekte bewegen Move (entlang einer Linie), Rotate (um eine Achse)  

 Objekte vermessen ►Modeler►Measure 

Material zuweisen: Assign Material  

 bestehendes Material aus Materialdatenbank  

o Magnetisierungsrichtung ändern: 1 oder 0 bei gewünschter Koordinate  

o BH-Kurve importieren ►BH Curve►Import Dataset (*.bh oder *.tab)  

o Parameter eines Permanentmagneten ändern Relative Permeability etc. 

Berechnungsraum definieren  

 mit Piktogramm Region Berechnungsraum ca. 200 % größer als Modell erstellen 

Lasten zuweisen:  

 Spule isolieren ►Assign Boundary►Insulating  

 Spule bestromen  
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o ►Edit►Surface►Section  

o ►Edit►Boolean►Seperate Bodies  

o eine der beiden entstandenen Querschnittsflächen auswählen, die andere wird 

gelöscht.  

o ►Assign Excitation►Current  

o Current kann sein Wert, Variable, Formel  

o Solid = Spule besteht aus Vollmaterial 

Stranded = Spule besteht aus Windungen 

Parameter zuweisen:  

 Kraft, Drehmoment  

 bewegliche Komponente auswählen, auf welche die Kraft bzw. das Drehmoment wirkt  

 ►Assign Parameter►Force/Torque 

manuelle Netzverfeinerung (optional):  

 ►Assign Mesh Operation►Inside Selection►Length based  

o maximale Kantenlänge der finiten Elemente  

o maximale Anzahl der finite Elemente 

Analysis Setup erstellen:  

 ►Analysis►Add Solution Setup  

o Maximum Number of Passes  

o Percent Error 

 Optimetrics (optional)  

o ►Optimetrics►Add►Parametric  

o Variable, Start, Stop, Schrittweite auswählen  

o bei Änderung immer Update auswählen 

o Reiter Options: Häkchen setzen bei „save mesh and fields“ (zum Speichern der 

grafischen Feldinformationen) und „copy geometrically equivalent meshes“ 

(nur falls sich während der parametrischen Analyse keine geometrischen Grö-

ßen ändern, lässt sich dieses Häckchen setzen) 

Berechnung starten:  

 Piktogramm Validate  

 Piktogramm Analyze all 

Ergebnisse ansehen:  

 alles auswählen ►Rechtsklick►Fields►B,H,A  

 Diagramme ►Results►Create Magnetostatic Report►Rectangular Plot  

 Daten exportierbar durch Rechtsklick auf das Diagramm ►Export  

 Tabelle ►Results►Solution Data 
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6 Physikalische Grundlagen des Magnetismus 

Das Programm MAXWELL dient der numerischen Berechnung von elektrostatischen und 

magnetischen Feldern. Für den Umgang mit dieser Software im Rahmen der Lehrveranstal-

tung „Engineering Tools“ am Fachgebiet Mikrotechnik der TU Berlin sind daher Kenntnisse 

einiger physikalischer Grundlagen erforderlich. Dieses Skript dient zur Vermittlung der we-

sentlichen physikalischen Inhalte - unabhängig von der verwendeten Software - auf der die 

Übungen und Hausaufgaben basieren. Dabei wird auf eine grundlegende und umfassende 

Beschreibung verzichtet und lediglich auf die übungsrelevanten Fragestellungen eingegangen.  

6.1 Magnetische Feldstärke H 

Die magnetische Feldstärke H ist ein Hilfsfeld, welches beispielsweise den Einfluss von mak-

roskopischen, z.B. in Drähten fließenden Strömen beschreibt. Wo immer ein Strom fließt, 

wird dieser von einem H-Feld umgeben. Dies wird durch die erste Maxwell’sche Gleichung 

ohne Verschiebungsstrom ausgedrückt. 

 
rot(H⃑⃑ )=j ,     ∮ H⃑⃑ ∙ds =Θ (6-1) 

Hiernach ist die Rotation des H-Felds an jeder Stelle gleich der verursachenden Stomdichte j. 

Nach dem Satz von Stokes ist dies gleichbedeutend mit der Aussage, dass jedes geschlossene 

Linienintegral des H-Felds gleich der Durchflutung Θ=N I ist, die durch die vom Integrati-

onsweg eingeschlossenen Fläche fließt. Im Inneren von Spulen konzentriert sich das H-Feld 

aus geometrischen Gründen. Für schlanke Zylinderspulen folgt aus (6-1) 

 
H=

NI

l
 (6-2) 

mit der Windungszahl N, der Spulenlänge l und dem Spulenstrom I.  

 

 

Abbildung 7:    Der Strom ist von einem H-Feld umgeben 
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6.2 Magnetische Induktion B 

Die magnetische Induktion B wird heute als das eigentliche Magnetfeld betrachtet, sie be-

stimmt die magnetischen Kräfte, wie Lorentzkraft und Reluktanzkraft und kann mit Hilfe von 

geeigneten Sensoren (z.B. Feldplatten oder Hallsensoren) gemessen werden. Die magnetische 

Induktion wird auch magnetische Flussdichte genannt, weil ihr Flächenintegral den magneti-

schen Fluss ergibt. Damit stellt sie das Pendant zur Stromdichte in elektrischen Kreisen dar. 

Auch der Begriff der magnetischen Feldlinien bezieht sich auf die magnetische Induktion. 

Ihre Richtung stimmt in jedem Punkt mit der Richtung des dortigen B-Vektors überein und 

ihre Dichte ist proportional zum Betrag von B. Das B-Feld ist quellenfrei, was mit der Aussa-

ge identisch ist, dass es keine magnetischen Monopole gibt. Dieser Zusammenhang wird ma-

thematisch durch die zweite Maxwell’sche Gleichung ausgedrückt. 

 
divB⃑⃑ =0,     ∮ B⃑⃑ ∙dA⃑⃑ =0 (6-3) 

Eine magnetische Induktion kann entweder mit Hilfe eines Permanentmagneten oder durch 

eine Spule nach dem Zusammenhang  

 B=μH (6-4) 

hervorgerufen werden. Die Proportionalitätskonstante μ heißt magnetische Permeabilität. Sie 

setzt sich nach 

 μ=μr∙μ0 (6-5) 

aus der magnetischen Feldkonstante oder Vakuumpermeabilität μ0=1,25710∙10-6 Vs

Am
 und der 

relativen Permeabilität μr zusammen. Letztere ist eine Materialeigenschaft. Für Luft hat sie 

etwa den Wert 1, während ferromagnetische Werkstoffe Permeabiliäten bis zu 100.000 auf-

weisen. Allerdings ist diese hierbei eine Funktion von H, also μr,Fe=μr,Fe(H). Materialien mit 

hohem μr reagieren bei gleichem H-Feld mit viel höherer magnetischer Induktion B als Luft 

oder Werkstoffe mit niedrigem μr. In Permanentmagneten gilt anstelle von (6-4) 

 B=BR+μH (6-6) 

da hier die Remanenz BR, also die durch den Magneten verursachte magnetische Induktion 

hinzukommt. Dies wird in Abschnitt 6.8 erläutert. Im Folgenden wird der Begriff Magnetfeld 

immer das B-Feld bezeichnen.  
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6.3 Magnetischer Fluss Φ 

Der magnetische Fluss Φ ist definiert als das Flächenintegral der magnetischen Induktion B. 

 
Φ=∫ B⃑⃑ ∙dA⃑⃑  (6-7) 

Ist B über den gesamten Querschnitt konstant und tritt senkrecht durch A, so vereinfacht sich 

dies zu Φ = B·A. Dies gilt näherungsweise in den meisten magnetischen Kreisen in kleinen 

Luftspalten.  

6.4 Magnetische Feldenergie 

Die magnetische Energiedichte ist gegeben durch 

 
wmag=

1

2
BH (6-8) 

Da B und H nach (6-4) außerhalb von Permanentmagneten in gleicher Richtung verlaufen, 

vereinfacht sich dies dort zu  

 
wmag=

1

2

B2

μ
 (6-9) 

Die gesamte Feldenergie des Systems ergibt sich als Volumenintegral seiner Energiedichte zu 

 
Wmag=∫wmagdV (6-10) 

 

6.5  Ferromagnetische Materialien 

Zunächst sei ein Ringkern betrachtet, auf den eine Spule gewickelt ist (vgl. Abbildung 8). Bei 

einer Windungszahl von N tritt ein Gesamtstrom von N·I (Spulenstrom I) durch den Kreis-

ring. Wendet man (6-1) in Integralform auf dieses System an: 

 
∮H ∙ds = N∙I (6-11) 

und wählt man als Integrationsweg die gestrichelt eingezeichnete Linie mit dem Umfang l, so 

ergibt sich Hl   NI, also  

 
H(l)=

N ∙ I

l
 (6-12) 

Die magnetische Feldstärke im Kreis ist folglich proportional zum Spulenstrom I. Das Ring-

material reagiert darauf mit einer magnetischen Induktion B = B(H). Dieser Zusammenhang 

ist bei ferromagnetischen Materialien nichtlinear und hysteresebehaftet (siehe Abbildung 8). 

Ist der Ring anfangs unmagnetisiert, so wird B bei steigendem Spulenstrom und damit bei 
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steigendem H zunächst der Neukurve folgen. An Punkt A würde eine weitere Erhöhung des 

H-Felds nur noch ein geringes Ansteigen der Induktion B nach (6-4) mit der Vakuumpermea-

bilität μ0 zur Folge haben. An diesem Punkt ist der Eisenkern magnetisch gesättigt. Reduziert 

man den Strom nun wieder bis auf Null, so folgt B dem eingezeichneten Verlauf bis zum 

Punkt B. Obwohl jetzt kein strombedingtes H-Feld mehr wirkt, bleibt eine magnetische In-

duktion BR zurück, die Remanenz genannt wird. Diese Remanenz ist es, die einen Dauermag-

neten zum Magneten im herkömmlichen Sinne macht.  

Bestromt man die Spule nun in Gegenrichtung, erreicht man bei der Feldstärke Hc, die Ko-

erzitivfeldstärke genannt wird, den Punkt C, an dem die magnetische Induktion den Wert Null 

annimmt. Erhöht man den Betrag des H-Felds weiter in negativer Richtung, so erreicht man 

schließlich den Punkt D, an dem das Eisen in umgekehrter Richtung gesättigt ist als an Punkt 

A. Bei einer erneuten Stromumkehr würde die magnetische Induktion nun der unteren Kurve 

der Hystereseschleife bis zum Punkt A folgen. Die in der Hystereseschleife enthaltene Fläche 

entspricht der Energie, die aufgebracht werden muss, um die Schleife einmal zu durchfahren. 

Diese Energie macht sich in Transformatoren als Magnetisierungsverlust bemerkbar.  

 

Abbildung 8:    Geschlossener Eisenkreis mit Spule (links) und  

                                      die BH-Kurve ferromagnetischer Materialien (rechts) 

 

6.6 Hart- und weichmagnetische Materialien 

In der Abbildung 9 sind die B-H-Kurven eines hart- und eines weichmagnetischen Materials 

abgebildet. hartmagnetische Materialien weisen eine breite Hysterese mit hoher Koerzitiv-

feldstärke HC auf und werden daher als Permanentmagnete eingesetzt. Bei weichmagneti-

schen Materialen ist die Hysterese sehr schmal ausgeprägt. Sowohl ihre Koerzitivfeldstärke 

als auch ihre Remanenz ist deutlich geringer als bei hartmagnetischen Materialen. Ihre Sätti-

gungsinduktion hingegen ist im Idealfall sehr hoch. Aufgrund dieser Eigenschaften wird 

Weicheisen zur Feldverstärkung in Spulen und als Leitung für den magnetischen Fluss ver-

wendet.  



 

Fachgebiet Mikrotechnik der TU Berlin 23 www.fmt.tu-berlin.de 

Ausschließlich für den Übungsgebrauch  Autor dieses Skripts: Dipl.-Ing. Martin Kelp 

 

 

Abbildung 9:    BH-Kurven ferromagnetischer Werkstoffe:  

                                           hartmagnetisch (links) und weichmagnetisch (rechts) 

Beispiele für Hartmagnetische Werkstoffe sind:  

 AlNiCo  

 Hartferrite  

 Seltenerdmagnete (SmCo, NdFeB) 

6.7 Magnetkreisberechnung 

Beispiel 1: Weicheisenkreis mit Spule und Luftspalt 

Versieht man den magnetischen Kreis aus der Abbildung 8 mit einem Luftspalt, so ergibt sich 

der in der Abbildung 10 gezeigte Aufbau. Dabei wirkt der Luftspalt aufgrund seiner niedrigen 

Permeabilität als magnetischer Widerstand, was gegenüber dem Kreis ohne Luftspalt einen 

geringeren Magnetfluss zur Folge hat. Aus (6-11) folgt  

 l ∙ HFe + δ∙HL=N∙I (6-13) 

Da Φ wegen (6-3) überall im Kreis, also auch im Luftspalt, den gleichen Wert haben muss, 

gilt Φ = ΦFe = ΦL = konstant. Da der Kreisquerschnitt A im gesamten Kreis konstant ist, folgt 

daraus wegen Φ = B·A;  B = BL = BFe. Berücksichtigt man weiterhin, dass B = BL = μL·HL, so 

ergibt sich aus (6-13)  

 
B = BL =

μL

δ
∙ NI − 

μL ∙ l

δ
∙ HFe (6-14) 

Zusammen mit der BH-Kurve von Eisen BFe = BFe (HFe) ergibt sich ein Gleichungssystem, das 

sich nach B auflösen lässt. Da die BH-Kurve jedoch nichtlinear ist, muss diese Lösung nume-

risch oder graphisch erfolgen, wie in der Abbildung 10 dargestellt.  

 

B B

HH

Br

Br

HC

HC

BS
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Für die folgende Betrachtung soll von einer linearen BH-Kurve  

 B = BFe = μFeH (6-15) 

ausgegangen werden. Damit lässt sich das Gleichungssystem (6-13), (6-15) lösen. Für den 

Arbeitspunkt ergibt sich dann  

 
B =

μL

l
∙

NI
μL
μFe

+δ
l

 (6-16) 

Da μFe  >>  μL, verringert sich der Einfluss des Summanden μL / μFe gegenüber dem geomet-

rieabhängigen Summanden δ / l bei gebräuchlichen Magnetkreisgeometrien deutlich. Der Ein-

fluss von μFe und damit auch die Nichtlinearität der BH-Kurve des Eisens nehmen daher 

durch den Luftspalt ab. Vernachlässigt man den Summanden μL / μFe in (6-16), so ergibt sich 

für die magnetische Induktion im Kreis in guter Näherung  

 B ≈ 
μL

δ
NI (6-17) 

Das gleiche Ergebnis hätte man erhalten, wenn man den Eisenterm in (6-13) von vorn herein 

weggelassen hätte. Dies bedeutet, dass der magnetische Widerstand des Eisens in magneti-

schen Kreisen, ähnlich wie der elektrische Widerstand des Kupfers in elektrischen Kreisen, 

im Vergleich zu dem in Luft vernachlässigt werden kann.  

 

Abbildung 10:    Magnetischer Kreis mit Luftspalt (links) und graphische Ermittlung seines  

      Arbeitspunktes in der BH-Neukurve von Weicheisen (rechts) 

Die oben angeführten analytischen Rechnungen basieren auf der Annahme, dass die Quer-

schnittsfläche des magnetischen Flusses im Eisen und im Luftspalt gleich groß ist. Tatsäch-

lich kann es jedoch zu Kurzschlüssen zwischen den Eisenteilen und Streuflüssen um den Ar-

beitsspalt herum kommen (siehe Abbildung 11 bis Abbildung 13). Die Berechnungen zu den 

Abbildungen entstammen aus MAXWELL 2D. Hierbei ist Θ = N·I = 4.000 A, der Eisenrück-

schluss aus Baustahl St37 mit 30 x 30 mm
2
 Querschnittsfläche, die Luftspaltlänge δ = 10 mm.  
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Abbildung 11:    Magnetischer Kreis mit Luftspalt, Darstellung der Feldlinien (MAXWELL 2D) 

In der Abbildung 13 ist der Verlauf der magnetischen Induktion B über der x-Achse (horizon-

tale Symmetrieachse, die durch die Mitte der Spule über den linken Eisenschenkel sowie 

durch den Luftspalt verläuft) dargestellt. Innerhalb des linken Eisenschenkels herrscht über 

eine Breite von 30 mm eine Induktion von knapp 1,1 T. Würde der magnetische Fluss perfekt 

durch das Eisen geführt und in einem parallelen Flussbündel durch den Arbeitspalt δ verlau-

fen, so herrschten aufgrund der Flusserhaltung in einem 30 mm breiten Luftspalt ebenfalls 

knapp 1,1 T. Aus dem Diagramm ist jedoch zu entnehmen, dass es unmittelbar außerhalb des 

linken vertikalen Eisenschenkels - und nicht nur im Arbeitspalt - zu Rückflüssen kommt. Die 

Induktion in dem Luftspalt beträgt aufgrund dieser Streuverluste in dem dargestellten Aufbau 

knapp 0,5 T. Eine Integration der Induktion über die x-Achse ergibt in der Summe Null. Da 

diese Streueffekte sehr stark von der Geometrie des Magnetkreises und den nicht-linearen 

magnetischen Eigenschaften der Werkstoffe abhängen, lässt sich kein verlässlicher Verlust-

faktor ermitteln, der diese Verluste in den analytischen Rechnungen berücksichtigen könnte. 

In diesem Zusammenhang wird die Bedeutung der numerischen Methoden ersichtlich, bei 

denen alle diese Einflüsse berücksichtigt werden.  
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Abbildung 12:    Darstellung der Induktion B im magnetischen Kreis mit Luftspalt 

 

Abbildung 13:    Darstellung des Verlaufs der Induktion B entlang der x-Achse  

                   im magnetischen Kreis mit Luftspalt (siehe Abbildung 12) 
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6.8 Ohm’sches Gesetz des Magnetismus 

Zur einfacheren Berechnung von Magnetkreisen, die aus Spulen und Weicheisen bestehen, 

lässt sich das Ohm’sche Gesetz des Magnetismus nutzen. Es stellt eine Analogie zwischen 

elektromagnetischen und elektrischen Kreisen dar und lautet  

 Θ = Rm ∙ Φ (6-18) 

Die magnetische Spannung zwischen zwei Punkten (P und Q) des Magnetkreises ist hierin 

definiert als 

 

Θ = ∫ H

Q

P

∙ dr (6-19) 

Der magnetische Widerstand ist definiert als  

 
Rm= 

1

μ0 ∙ μr ∙ A
 (6-20) 

Das Pendant zum elektrischen Strom ist der magnetische Fluss Φ nach (6-7). Das Gesetz ist 

eine Folge aus (6-4), (6-7) und der Definition (6-19). Tatsächlich hat es nichts mit einem Lei-

tungsmechanismus zu tun, sondern vereinfacht lediglich die Berechnung magnetischer Kreise. 

Angewandt auf den Kreis in der Abbildung 10 würde es lauten: 

 
NI = Φ ∙ (Rm,Fe + Rm,Luft) =  Φ ∙ (

1

μ0μrA
+

δ

μ0ALuft
) (6-21) 

Unter Verwendung von AFe = ALuft  = A sowie Φ = B·A ergibt sich hieraus selbstverständlich 

das gleiche Ergebnis wie in (6-16). Wegen (6-3) gilt auch die Knotenregel 

 ∑Φi

i

 =0 (6-22) 

und wegen (6-1) zusammen mit der Definition (6-19) auch die Maschenregel für Θ. Damit 

sind alle Rechenverfahren zur Berechnung elektrischer Kreise auch auf magnetische Kreise 

anwendbar. Die Entsprechungen zwischen elektrischen und magnetischen Kreisen sind in der 

Tabelle 2 zusammengefasst.  

 

magnetische Größe elektrisches Pendant 

magnetische Spannung  Θ = N·I  elektrische Spannung   U  

magnetischer Fluss   Φ = B·A  elektrischer Strom   I  

magnetischer Widerstand  R=
1

μrμ0A
 elektrischer Widerstand  R 

Tabelle 2:    Analogie zwischen magnetischen und elektrischen Größen 
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Beispiel 2: Kreis mit Permanentmagnet und Luftspalt 

 

Abbildung 14:    Permanentmagnetischer Kreis mit Luftspalt (links) und die graphische  

                                   Ermittlung seines Arbeitspunktes im zweiten Quadranten der BH-Kennlinie eines 

Permanentmagneten (rechts) 

Aus (6-11) folgt für den permanentmagnetischen Kreis nach der Abbildung 14 

 HMlM+HFelFe+HLlL=0 (6-23) 

Im Folgenden wird davon Gebrauch gemacht, dass der magnetische Widerstand von Eisen 

vernachlässigbar ist (siehe oben, μFe  >>  μL, μM). Damit verkürzt sich dies zu  

 HMlM+HLlL=0 (6-24) 

Diese Gleichung kann nur dann erfüllt sein, wenn HM und HL entgegengesetzte Vorzeichen 

haben. Da im Luftspalt wegen (6-4) HL parallel zu BL verläuft und damit positiv ist und B 

wegen (6-7) überall im Kreis die gleiche Richtung hat, muss HM in Permanentmagneten nega-

tiv sein. Damit befindet sich der Arbeitspunkt eines Permanentmagneten zwangsläufig im 

zweiten Quadranten der BH-Kurve, da nur hier B positiv und H negativ ist. Da der magneti-

sche Fluss Φ wegen (6-4) überall im Kreis, also auch im Luftspalt, den gleichen Wert haben 

muss, gilt Φ = ΦM = ΦL = konstant. Da der Kreisquerschnitt A im gesamten Kreis konstant ist, 

folgt daraus wegen Φ = B·A, B = BM = BL. Berücksichtigt man weiterhin, dass 

B = BL = μL·HL, so ergibt sich aus (6-24) 

 
B = -

μLl

δ
HM (6-25) 

Zusammen mit der BH-Kurve des Permanentmagneten BM = BM (HM) ergibt sich ein Glei-

chungssystem, das sich nach B auflösen lässt. Da die BH-Kurve jedoch nichtlinear ist, muss 

diese Lösung numerisch oder, wie in der Abbildung 14 dargestellt, graphisch erfolgen. Befin-

det sich der Arbeitspunkt hinter dem Knick der BH-Kurve, so ist ein Reduktion der 

Remanenz und damit eine dauerhafte Schwächung des Permanentmagneten die Folge. Bei 

NdFeB-Magneten (Neodym-Eisen-Bor), verläuft die BH-Kurve im gesamten zweiten Quad-

ranten näherungsweise linear, so dass man sie durch  

 B =BR + μMHM (6-26) 
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beschreiben kann. Löst man das Gleichungssystem (6-25), (6-26), so erhält man die Kreisin-

duktion.  

 
B =BR

1

1 + μM
μL

 
δ
lM

 (6-27) 

Da μM ≈ μL, wird diese Beziehung vom Verhältnis aus Luftspaltlänge und Magnetlänge δ / lM 

bestimmt. Ist der Luftspalt im Verhältnis zur Magnetlänge sehr klein, so herrscht im Kreis in 

etwa die Remanenzinduktion BR. Sind Luftspalt- und Magnetlänge gleich, so herrscht etwa 

BR / 2. In der Abbildung 15 ist (6-24) als Funktion von δ / lM dargestellt.  

 

Abbildung 15:    Magnetische Induktion B als Funktion des Verhältnisses aus Luftspaltlänge 

und Magnetlänge für einen permanentmagnetischen Kreis 

6.9 Magnetkräfte 

Es gibt zwei Arten von Kräften die durch Magnetfelder verursacht werden:  

 Lorentzkraft  

 Reluktanz- oder Maxwellkraft 

Erstere wirkt auf bewegte Ladungen, während letztere auf dem Bestreben magnetischer Sys-

teme beruht, die Gesamtfeldenergie zu reduzieren. An dieser Stelle soll nur auf die Re-

luktanzkraft eingegangen werden.  

6.9.1 Reluktanzkräfte 

Jedes physikalische System, dessen Energiegehalt W sich durch die mechanische Verschie-

bung einer Komponente reduzieren lässt, übt eine Kraft F auf diese Komponente in der ent-

sprechenden Richtung aus: 

 F⃑  = - grad W  (6-28) 

In (6-28) liegt die Ursache für die Reluktanzkraft begründet. Da μ in (6-9) im Nenner steht, 

verursacht ein durch Luft verlaufendes Magnetfeld viel höhere Energiedichten als ein durch 
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Eisen verlaufendes. Permanentmagnete haften deshalb an Weicheisen, weil dadurch das Vo-

lumen des durch Luft verlaufenden Felds und damit die Gesamtfeldenergie minimiert wird. 

Beispiel 3: Haltekraft eines Hufeisenmagneten 

Für viele Systeme ist die Feldverteilung nicht analytisch berechenbar. Eine Ausnahme stellt 

die Haltekraft eines Hufeisenmagneten dar, siehe Abbildung 16.  

 

Abbildung 16:    Haltekraft eines Hufeisenmagneten 

Bei sehr kleinen Luftspalten x herrscht im Kreis näherungsweise die Remanenzinduktion des 

Permanentmagneten. Außerdem bleibt die Feldenergie im Eisen dann unabhängig von x kon-

stant. Deshalb genügt es, nur die Feldenergie im Luftspalt zu betrachten. Diese ergibt sich 

nach (6-9) und (6-10) zu  

 
W(x) = ∫

1

2

BR
2

μL
dV = 

V

1

2

BR
2

μL
Ax (6-29) 

mit der gesamten Berührfläche A zwischen Magnet und Joch (in der Abbildung 16 über zwei 

Teilflächen A/2 verteilt). In diesem Fall wird aus der Vektorgleichung (6-28) eine skalare 

Gleichung. Dadurch wird aus dem Gradienten eine einfache Differentiation nach x. Für den 

Betrag von F gilt damit  

 
F = 

∂

∂x
(
1

2

BR
2

μL
Ax) =

1

2

BR
2

μL
A (6-30) 

oder ausgedrückt durch den Fluss  

 
F = 

1

2

ΦR
2

μLA
 (6-31) 

6.9.2 Maxwell’sche Zugkraftformel 

Weiter oben erfolgte die Betrachtung der Feldenergie im Luftspalt.Sie wird letztlich durch 

den Austritt des B-Felds aus einem hochpermeablen Material in Luft verursacht. Deshalb 

müssen die Zusammenhänge (6-30), (6-31) ganz allgemein für jedes ungesättigte Weicheis-
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enteil, aus dem Feldlinien austreten, gelten. Dieser Zusammenhang wird als Maxwell’sche 

Zugkraftformal bezeichnet.  

 
F = 

1

2

B2

μL
A =  

1

2

ΦR
2

μLA
 (6-32) 

Hierin bezieht sich B auf die durch die Oberfläche A tretende Induktion. Gelingt es, die Feld-

verteilung um ein Weicheisenteil zu berechnen, so kann die Kraftwirkung mit Hilfe von (6-

32) für die gesamte Oberfläche einer Komponente bilanziert und so die resultierende Re-

luktanzkraft berechnet werden. Diese Art der Kraftberechnungen ist in den entsprechenden 

numerischen Computerprogrammen zur Feldberechnung implementiert. An dieser Stelle sei 

noch einmal darauf hingewiesen, dass mögliche Fehler einer rein analytischen Berechnung 

der Zugkraft bei der Bestimmung des magnetischen Flusses entstehen, da sich die Verluste 

durch Streuflüsse analytisch schwer quantifizieren lassen und die nichtlinearen Materialeigen-

schaften berücksichtigt werden müssen.  

6.9.3 Horizontale Kraftwirkung der Reluktanzkraft 

Abgesehen von der Magnetkraft als Normalkraft, kann die Verringerung der Reluktanz eben-

so als tangentiale Kraft genutzt werden. In der Abbildung 17 ist der magnetische Kreis mit 

einem horizontal beweglichen Element dargestellt. Wenn sich das Element weiter nach rechts 

bewegt, wird der Luftspalt kleiner und damit der Weg des magnetischen Felds durch den 

Luftspalt kürzer. 

 

Abbildung 17    Reluktanzkraft - horizontal wirkend 

Die entstehende Kraft ist nicht analytisch berechenbar. Mit Hilfe von geeigneten Modellrech-

nungen mit Finite Elemente Programmen (z.B. MAXWELL) können jedoch numerische Lö-

sungen für die Wirkung der Reluktanzkraft ermittelt werden 
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6.9.4 Lorentzkraft 

Bewegt sich ein Teilchen der Ladung q in einem Magnetfeld B


 mit einer Geschwindigkeit v


, 

so wird auf dieses Teilchen eine Kraft LF


 ausgeübt, wenn die Bewegungsrichtung v


 senk-

recht zur Richtung des magnetischen Felds B


 ist. 

 BvqFL


  (6-33) 

Zu beobachten ist die Lorentzkraft beispielsweise bei einer stromdurchflossenen Leiter-

schleife im Magnetfeld. Fließt durch den elektrischen Leiter ein Strom, so kommt es zur Be-

wegung von geladenen Teilchen (technische Stromrichtung). Steht die Leiterschleife senk-

recht zum Magnetfeld, wirkt die Lorentzkraft. In der Abbildung 18 ist ein stromdurch-

flossener Leiter im Magnetfeld abgebildet. 

 

Abbildung 18    Stromdurchflossener Leiter im Magnetfeld: Lorentzkraft 

Die Lorentzkraft auf die Leiterschleife ist abhängig von der im Magnetfeld befindlichen Lei-

terlänge l


, der Stromstärke I und der magnetischen Flussdichte LB


. 

 
LL BlIF


  (6-34) 

Wie beschrieben, wirkt diese Kraft auf einen stromdurchflossenen Leiter im Magnetfeld, 

wenn Magnetfeld und Stromrichtung senkrecht zueinander wirken. Im Gegensatz dazu kann 

die Lorentzkraft auch auf einen beweglichen Magneten wirken, wenn der stromdurchflossene 

Leiter fest steht. 

l

HL, BL

S

N

I

FL

S

N
lM


